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While Deltek has attempted to verify that the information in this document is accurate and complete, 

some typographical or technical errors may exist. The recipient of this document is solely responsible for 

all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject 

to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. 

No part of this document may be reproduced or transmitted in any form or by any means, electronic or 

mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published April 2026. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 

proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 

documentation, is provided for use only in accordance with the terms of the license agreement. 

Unauthorized reproduction or distribution of the program or any portion thereof could result in severe 

civil or criminal penalties. 

All trademarks are the property of their respective owners.  

 

  



 

Installation Guide iii 

 

Contents 
OVERVIEW ..........................................................................................................................................................................1 

ADDING CUSTOM NOTES TO THIS GUIDE ...................................................................................................................................... 1 
DOWNLOADING DELTEK PRODUCTS USING DELTEK SOFTWARE MANAGER ............................................ 2 

ACCESSING DSM FROM WITHIN THE DELTEK SUPPORT CENTER .............................................................................................. 2 
ACCESSING DSM LITE ....................................................................................................................................................................... 3 
DSM DOCUMENTATION AND TROUBLESHOOTING ....................................................................................................................... 3 

BEFORE YOU BEGIN DEPLOYMENT ............................................................................................................................ 4 
LOGICAL TIERS OVERVIEW ............................................................................................................................................................... 4 
DEPLOYMENT MODELS ...................................................................................................................................................................... 4 

Stand-Alone Deployment ...................................................................................................................................................... 4 
Client/Server Deployment ..................................................................................................................................................... 4 

QUESTIONS TO ASK BEFORE YOU BEGIN ....................................................................................................................................... 5 
INSTALLATION STEPS .......................................................................................................................................................................... 5 

SYSTEM REQUIREMENTS .............................................................................................................................................. 7 
HARDWARE SIZING CONSIDERATIONS ........................................................................................................................................... 7 

Memory Requirements for a Typical/Average Use ...................................................................................................... 7 
Definition of Typical/Average Use ..................................................................................................................................... 8 

HARDWARE REQUIREMENTS............................................................................................................................................................. 8 
SOFTWARE REQUIREMENTS .............................................................................................................................................................. 8 

Supported Deployment Technology .................................................................................................................................. 9 
Supported PPM Product Versions ......................................................................................................................................11 
Compatible Deployment Technology .............................................................................................................................. 12 
Open-Source Software Included with wInsight Analytics ..................................................................................... 12 

INTEGRATE WINSIGHT ANALYTICS WITH OTHER PPM PRODUCTS .......................................................................................... 13 
INSTALL WINSIGHT ANALYTICS DESKTOP ........................................................................................................... 15 
INSTALL WINSIGHT ANALYTICS DESKTOP ON A NETWORK SHARE SETUP ............................................. 16 

INSTALLATION NOTES....................................................................................................................................................................... 19 
UPGRADE FROM AN EARLIER VERSION OF WINSIGHT ANALYTICS DESKTOP ........................................ 21 

BACK UP CONTRACTS FROM AN EARLIER VERSION OF THE WINSIGHT ANALYTICS DATABASE ....................................... 22 
Manually Create a Backup of Contracts in an MS SQL, Oracle, or MS Access Database ......................... 22 

BACK UP COPIES OF EXISTING MDB FILES ................................................................................................................................. 22 



 

Installation Guide iv 

 

MODIFY, REPAIR, OR UNINSTALL WINSIGHT ANALYTICS DESKTOP ........................................................... 23 
CONVERT AN EARLIER VERSION OF THE MS ACCESS DATABASE ............................................................. 24 

CONVERT AN MS ACCESS DATABASE ......................................................................................................................................... 24 
Upgrade from the Previous Version ................................................................................................................................ 24 

SET UP AND CREATE A NEW DATABASE ...............................................................................................................26 
STEPS FOR SETTING UP A NEW DATABASE ................................................................................................................................. 26 
CREATE A NEW DATABASE ............................................................................................................................................................. 27 

Create an MS Access Database ........................................................................................................................................ 27 
ADVANCED SETUP OPTIONS .................................................................................................................................... 28 

CONFIGURE WINSIGHT ANALYTICS DESKTOP TO USE LONG ELEMENT DESCRIPTIONS .................................................... 28 
TROUBLESHOOTING WINSIGHT ANALYTICS DESKTOP .................................................................................. 30 

CONTACT TECHNICAL SERVICES .................................................................................................................................................. 30 
SEND FILES TO DELTEK .................................................................................................................................................................... 30 
ERROR ENCOUNTERED WHEN USING THE SQL.NET FRAMEWORK DATABASE PROVIDER .............................................. 30 

APPENDIX A: DATA TOOL ........................................................................................................................................... 32 
ADD A DATA SOURCE ...................................................................................................................................................................... 32 
EDIT A DATA SOURCE ...................................................................................................................................................................... 34 
DELETE A DATA SOURCE ................................................................................................................................................................. 34 

APPENDIX B: USING THE PPM SECURITY TOOLS ................................................................................................ 35 
APPENDIX C: IF YOU NEED ASSISTANCE .............................................................................................................. 36 

CUSTOMER SERVICES ...................................................................................................................................................................... 36 
DELTEK SUPPORT CENTER .............................................................................................................................................................. 36 
ACCESS DELTEK SUPPORT CENTER .............................................................................................................................................. 37 
ADDITIONAL DOCUMENTATION ..................................................................................................................................................... 37 

 

 



 

Installation Guide 1 

 

Overview 
Welcome to the wInsight Analytics Desktop 8.3.4 Installation Guide. Use this document to install 

wInsight Analytics Administrator on your system. 

Adding Custom Notes to This Guide 

If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X 

provides this ability. If you do not already use Adobe Reader X, you can download it here free from 

Adobe.  

To add a custom note using Adobe Reader X: 

1. On the Reader toolbar, click Comment at the far right. 

2. In the Annotations pane that displays, click  Sticky Note. 

The cursor changes to match the button. 

3. Position the cursor at the location in the guide where you want the note to appear and click. 

A note icon is inserted at the location and a text box pops up. 

4. Enter your information in the text box. 

5. Continue adding notes as needed. 

6. Save the document. 

 

When reading the document, cursor over a note icon to see the information. Double-click a note icon to 

edit the information. 

Note: Deltek recommends that you save the document to a slightly different filename so as to keep 

the original from being overwritten. 

http://get.adobe.com/reader/
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Downloading Deltek Products using Deltek 
Software Manager 
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 

cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 

Deltek Software Manager Lite to download Deltek products. 

Accessing DSM from within the Deltek Support Center 

To access DSM from within the Deltek Support Center: 

1. In your Web browser, go to https://deltek.custhelp.com.  

2. Enter your Deltek Support Center Username and Password and click Login. 

3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 

5. Click Settings at the top right of the dialog box to use the Settings dialog box to specify the 

folder where you want to download Deltek products and click OK.  

 

6. In the left pane, expand the Deltek product that you want to download, if it is not already 

expanded.  

7. Select the product type that you want to download.  

Options include: 

 Complete 

 Cumulative Updates 

 HotFixes 

 Sub-Release 

8. In the table, select the check box that corresponds to the Deltek product that you want to 

download.  

The right pane displays a message stating that the product has been added to the download 

queue. 

Note: When you log on for the first time, DSM asks you to select a default folder where 

Deltek products are to be downloaded. 

You can change this folder anytime in the Settings dialog box. 

https://deltek.custhelp.com/
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9. Click Download at the bottom of the left pane to download the product to the folder that you 

selected.  

Accessing DSM Lite 

To access Deltek Software Manager Lite: 

1. In your Web browser, go to https://dsm.deltek.com/DeltekSoftwareManagerLite.  

2. Enter your Deltek Support Center Username and Password and click Logon. 

3. When the Deltek Software Manager Lite page displays, select a product from the drop-down list. 

4. Click the product type that you want to download.  

 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

Note: To view the items in the download queue, click View Download Queue at the bottom 

of the left pane. 

Note: The download behavior and download folder may differ depending on the browser 

and browser settings that you are using. 

Note: When you click a link, you will be asked to log into DSM if you aren’t already logged in. 

https://dsm.deltek.com/DeltekSoftwareManagerLite
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://deltek.custhelp.com/app/answers/detail/a_id/50668
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Before You Begin Deployment 
Before you begin deployment, it is important to understand the following: 

Logical Tiers Overview 

The wInsight Analytics product suite uses multitier (n-tier) architecture. Various parts of a wInsight 

Analytics product are distributed to logical tiers for performance and scalability. The logical tiers are as 

follows: 

 Client/Application Tier: This tier performs wInsight Analytics functional process logic and 
provides the user interface layer. It can be a workstation or a Citrix/Terminal Server. 

 Database Tier: This tier consists of database servers where the wInsight Analytics data is stored 
and retrieved. 

 

Deployment Models 
Stand-Alone Deployment 

Deltek wInsight Analytics Administrator and wInsight Analytics Desktop have a stand-alone deployment 

model. In a stand-alone deployment model, the applications are installed locally to the user’s PC or 

laptop and can connect to a local Access database. This deployment mode can be useful where a single 

user is managing and reporting data for a small number of contracts. 

Client/Server Deployment  

In the client/server model, you install the client/application tier on workstations that directly connect to 

a database server. However, when a client workstation that is connected to the database goes through a 

WAN or VPN, this type of setup can yield poor performance. The applications can be deployed in a 

Citrix/Terminal Server environment to improve performance over a WAN or VPN. 

Note: Deltek recommends, as part of best practice, to install all products in the PPM suite 

into the same database. The installations apply schema changes (tables, views, stored 

procedures, and so on) to your existing database in order to support the integration. While it 

is highly recommended that you install wInsight Analytics and Acumen into the same 

database, the integration between PM Compass, Open Plan, and Cobra requires it. 
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In addition, the application can be installed such that the application files reside on a network share on a 
machine and a shortcut is created on each workstation. 

Questions to Ask Before You Begin 

You should answer the following questions before installing wInsight Analytics Desktop: 

 Are you upgrading from an earlier version of wInsight Analytics Desktop? For steps, see the 
Upgrade from an Earlier Version of wInsight Analytics Desktop section. 

 Are you performing a fresh install of the wInsight Analytics Desktop on a local machine? For 
steps, see the Install wInsight Analytics Desktop section. 

 Do your client workstations and servers meet hardware and software requirements? For steps, 
see the System Requirements section. 

 Are you using Microsoft Access, Oracle, or Microsoft SQL as your database platform? For steps, 
see the Set Up and Create a New Database section. 

Installation Steps 

Follow this sequence to successfully install wInsight Analytics Desktop: 

Step Description  

1 Make sure that your system meets the hardware 

requirements to install the required software. 

System Requirements 

2 Download the wInsight Analytics Desktop installer from the 

Deltek support site. 

Downloading Deltek Products 
using Deltek Software 
Manager 

3 Prior to installing the new version of wInsight Analytics 

Desktop, protect your existing data by making backups of 

your database. Have your Database Administrator back up 

your Oracle/SQL databases or make copies of your Access 

.mdb database files. 

Back Up Contracts from an 
Earlier Version of the wInsight 
Analytics Database 

4 Install the wInsight Analytics Desktop. 
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Step Description  

 If you are upgrading from an earlier version of wInsight 

Analytics Desktop, make sure that you have recently 

backed up your wInsight Analytics data. 

Upgrade from an Earlier 
Version of wInsight Analytics 
Desktop 

 Perform a new installation of wInsight Analytics 

Desktop. 

Install wInsight Analytics 
Desktop 

or 

Install wInsight Analytics 
Desktop on a Network Share 
Setup  

5 Perform one of the following steps to create or upgrade the database tables. 

 Upgrade your existing database by running upgrade 

scripts. 

Convert an Earlier Version of 
the MS Access Database 

 Create a new database. Create a Database 

6 Run the data tool to set up a connection to the database 

used to store wInsight Analytics data. 

Appendix A: Data Tool 

7 Download and install PPM Administrator 1.0 or EPM SA 8.6 

(if not already installed), then launch it to define security 

rights to wInsight Analytics users. 

 

Appendix B: PPM Security 
Tools 

Note: Once you install PPM Administrator 1.0 or EPM 

SA 8.6, you can use it across all PPM products. If you 

use PPM Administrator, you can access it via a URL 

because it is a web-based tool. If you use EPM SA 8.6, 

you can only access it on the computer where you 

installed it..  
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System Requirements 
Your organization has made a substantial commitment to ensure it has a fully integrated earned value 

management (EVM) solution. To support that commitment, Deltek recommends that you carefully 

consider the hardware requirements necessary to run a wInsight Analytics product properly. 

Hardware Sizing Considerations 

There are several factors that go into sizing an appropriate server infrastructure. The number of 

concurrent users accessing the system at any given time, amount of data being analyzed, and growth 

expectations all have an impact on the initial sizing plans. The hardware profiles provided in the previous 

sections are intended as a starting point for deployment. It is expected that our clients will use the 

product in many different ways, such as planning for future release and client customizations.  

Memory Requirements for a Typical/Average Use 

Below are details on the memory footprint of the product. This can be helpful when sizing a client tier 

that runs in a virtual environment, Citrix®, or Terminal Server. 

Tier Memory* 

Client/Application Tier 2 GB (assuming the wInsight Analytics Module is being run as a server 

application). 

Database Tier Database instance memory should be 10%–15% of the database size. 

For example, if database size is expected to be 500 GB, then allocate 

50 GB–75 GB memory. 
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Definition of Typical/Average Use 

Sample details for a typical small/medium data sizing: 

 Number of Contracts: 50 

 Number of Element Records: 50,000   

 Number of Earned Value Records: 1,200,000 

 Number of Past and Future Period Records: 75,000,000 

Hardware Requirements 

The following table lists the recommended minimum hardware and software requirements for a 

deployment in a stand-alone or client/server environment. 

Tier Hardware Required Determining Factors 

Client\/Application Tier  Intel Core 2.0 Duo or higher 
 4 GB RAM (Depending on data volumes, 

more may be required.) 

 80 GB Hard Drive (More may be required 
if wInsight Analytics uses a Microsoft 
Access database to store data on the 
local machine) 

 Database Size 

 Database Growth 

Software Requirements 

 

  

Note: Supported versions are the currently actively tested versions of technologies used to deploy 

wInsight Analytics. Except for the Deltek Integrated Products, these technologies are not directly 

supported by Deltek. Changes to these technologies occur at the discretion of the individual 

technology vendors.  

Compatible versions are the recent previously supported and tested technologies used to deploy 

wInsight Analytics. These are not actively being tested but are believed to be compatible with 

wInsight Analytics. Deltek does not recommend these technologies for new deployments but will 

make its best effort to answer questions concerning these technologies. These technologies may 

not be available for troubleshooting at Deltek. 

For a complete list of the recommended minimum software requirements, see the Deltek Product 

Support Compatibility Matrix document that you can download from the Deltek Support Center. 

https://deltek.custhelp.com/app/utils/login_form/redirect/home


 

Installation Guide 9 

 

Supported Deployment Technology 

The table below outlines the supported deployment technologies for stand-alone and network share 

installations. 

Supported Deployment Technology 

Operating System Microsoft Windows 

 Microsoft Windows 11 

Microsoft Windows Server 

 Microsoft Windows Server 2019 

 Microsoft Windows Server 2022 

 Microsoft Windows Server 2025 

 Microsoft Windows Server 2022 Azure Edition 

VMWare Horizon VMWare Horizon 8 

Database Microsoft SQL Server  

 Microsoft SQL Server 2019 (also supported on Linux and Unix) 

 Microsoft SQL Server 2022 (also supported on Linux and Unix) 

 Microsoft Azure SQL Server  

Microsoft SQL Server Express 

 Microsoft SQL Server Express 2019 

 Microsoft SQL Server Express 2022 

Microsoft Access 

 Microsoft Access 2016 

 Microsoft Access 2019 

 Microsoft Access 2021 

Oracle 

 Oracle 19.3 

 Oracle is also supported on Linux, Unix and Exadata 

 

Note: If the database instance does not support Unicode character 

set, the Unicode flag (@unicode) in the database table creation 

scripts should be set to 0. 
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Supported Deployment Technology 

Database Drivers 

 

 Oracle Provider for OLE DB 

 Microsoft SQL Server 2012 Native Client, version 11.4.7001.0 or higher 

 Microsoft OLE DB Driver for SQL Server, version 18.2.2.0 or higher 

 Microsoft OLE DB Provider for Jet 

 Microsoft ACE OLEDB 15 

 Microsoft ACE OLEDB 16 

Scheduling Tools Microsoft Project Standard 

 Microsoft Project Standard 2021 (32-bit only) 

 Microsoft Project Standard 2024 (32-bit only) 

Microsoft Project Professional  

 Microsoft Project Professional 2021 (32-bit only) 

 Microsoft Project Professional 2024 (32-bit only) 

Microsoft Project Server 

 Microsoft Project Server 2016 

Oracle Primavera 

 Primavera P6 20.12 

 Primavera P6 21.12 

 Primavera P6 22.12 

 Primavera P6 23.12 

 Primavera P6 24.12 

Microsoft Office  Microsoft Excel 

 Microsoft Excel 2021 (32-bit only) 

 Microsoft Excel 2024 (32-bit only) 

 Microsoft Excel 365 (32-bit only) 

Microsoft PowerPoint 

Note: wInsight Analytics applications support 32-bit and 64-bit 

drivers, depending on the version of the application you are using.  
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Supported Deployment Technology 

 Microsoft PowerPoint 2021 (32-bit only) 

 Microsoft PowerPoint 2024 (32-bit only) 

Embedded 

Technologies 

 Visual C++ 2017 Redistributable Package (x86) 

 Visual C++ 2015-2022 Redistributable Package (x86) 

 Visual C++ 2017 Redistributable Package (x64) 

 Visual C++ 2015-2022 Redistributable Package (x64) 

 MSXML 6.0 Service Pack 2 (Microsoft XML Core Services) 

.NET Framework  Microsoft .Net Framework 4.8 

 Microsoft .Net Framework 4.8.1 

 

Supported PPM Product Versions 

The table below outlines the PPM product versions compatible with wInsight Analytics 8.3.4. The 

versions listed below are the minimum supported versions. Subsequent cumulative update (CU) releases 

within the listed major/minor release will be supported unless otherwise specified. Subsequent 

major/minor releases are not supported. 

Supported PPM Product Versions 

Deltek Acumen   8.10 

 8.11 

Deltek Cobra  8.6 

 8.7 

Deltek Open Plan   8.6 

 8.7 

 8.8 

PPM Administrator  1.0 

Attention: You can download the Microsoft.NET Framework from 

Microsoft’s Web site at http://www.microsoft.com/en-

us/download/details.aspx?id=17718. For instructions for adding it 

using Server Manager, see your Microsoft Windows documentation. 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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Supported PPM Product Versions 

EPM Security 

Administrator 

 8.6 

Compatible Deployment Technology 

The table below outlines the compatible deployment technologies. 

Compatible Deployment Technology 

Operating System  Microsoft Windows Server 2016 

Database  Microsoft SQL Server 2016 

 Microsoft SQL Server 2017 

 Microsoft SQL Server Express 2016 

 Microsoft SQL Server Express 2017 

 Oracle 12.2 

Scheduling Tools  Microsoft Project Standard 2013  

 Microsoft Project Professional 2013 

 Microsoft Project Server 2013 

 Primavera P6 17.12 

 Primavera P6 18.8 

 Primavera P6 19.12 

Deltek Integrated 

Product 

 Deltek MPM 3.5 

Open-Source Software Included with wInsight Analytics 

wInsight Analytics includes the following open source software: 

Software  Company 

Zlib 1.3.1 SourceForge 

jpeg.lib Independent JPEG Group 
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Integrate wInsight Analytics with Other PPM Products  

Before integrating wInsight Analytics with any PPM products, including Acumen, Cobra, Open Plan, and 

PM Compass, Deltek recommends that you consider the following: 

 Verify that you are installing the supported version of each PPM product.  

 

 For a new installation on a shared database, where wInsight Analytics 8.3.4 is installed first, older 
versions of other PPM products that do not support the new encryption protocol will neither 
function nor integrate with wInsight Analytics 8.3.4.  

 You should consider installing or upgrading all products in the Deltek PPM suite to versions that 
support the new encryption model.  

 

This table lists the versions that support the new encryption model:  

Product Version 

Acumen 8.9 or later 

Acumen Touchstone  8.2 or later 

Cobra 8.5 or later 

Open Plan 8.6 Cumulative Update 05 or later 

PM Compass 8.4 Cumulative Update 02 or later 

wInsight Analytics 8.3.2 or later 

 If you are installing wInsight Analytics on a database that already contains another Deltek PPM 
application that is not configured to use Unicode, you must first update the existing database 
tables to use Unicode structures before installing wInsight Analytics 8.3.4. 

  

Attention: For more information, see “Supported PPM Product Versions” under System 

Requirements in this guide. 

Attention: For more information on the encryption model, see “Appendix E: PPM Encryption 

Conversion Utility” in the wInsight Analytics Administrator Installation Guide. 
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 If you are setting up a new database that will include the Open Plan 8.7 (CU 05 or earlier) or 8.6 
(CU 10 or earlier), you need to run the Open Plan scripts prior to running scripts for other PPM 
products. 

 Run any recommended installation and upgrade database scripts.  

 

 

Attention: For installation details, see the Installation Guide of each PPM product. 
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Install wInsight Analytics Desktop 
Use this procedure to perform a fresh install of wInsight Analytics Desktop.  

 

To install wInsight Analytics Desktop: 

1. Download the wInsight Analytics Desktop installer from DSM. For steps, see Downloading Deltek 
Products using Deltek Software Manager. 

2. Navigate to the location where you saved the installer and double-click one of the following to 
launch the InstallShield Wizard: 

 For 64-bit: DeltekwInsightAnalyticsDesktop834x64.exe 

 For 32-bit: DeltekwInsightAnalyticsDesktop834.exe 

3. On the Welcome page, click Next. 

4. On the Setup Type page, do one of the following: 

 Select Complete to install all components and click Next. 

By default, the wInsight Analytics Desktop is installed in any of the following locations:  

1. For 64-bit: C:\Program Files\Deltek\wInsight Analytics\ 

2. For 32-bit: C:\Program Files(x86)\Deltek\wInsight Analytics\ 

 Select Custom to choose program features to install and click Next. 

3. On the Custom Setup page, click Change to change the folder where the application will be installed 

or one of the  icons to change the features installed, and click Next. 

5. On the Ready to Install the Program page, click the Install button to start the installation 
process. The Installing Deltek wInsight Analytics Desktop page displays the installation progress. 

6. On the InstallShield Wizard Completed page, click the Finish button to exit the InstallShield 
Wizard. You can select the check box to launch the application after installation is completed.  

 

 

Attention: If you are re-installing/upgrading the wInsight Analytics Desktop, see Upgrade from an 

Earlier Version of wInsight Analytics Desktop. 

If you want to install wInsight Analytics Desktop to run from a server, perform the steps below on 

the server only. You will need to perform additional steps after you complete the installation. For 

more information, see Install wInsight Analytics Desktop on a Network Share Setup. 
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Install wInsight Analytics Desktop on a 
Network Share Setup 
You can install wInsight Analytics Desktop files (exe, .dll, or .htm) and other related files on a server and 

run wInsight Analytics Desktop from a client PC. The software runs on the client PCs even though all 

wInsight Analytics Desktop files are stored on the server. Certain files, however, must reside on the client 

PC (for example, MDAC 2.5), and certain .DLL files must be registered. You should create a shortcut on 

the client PC to launch wInsight Analytics Desktop. 

 

To set up wInsight Analytics Desktop to run from a server: 

1. Install wInsight Analytics Desktop on the server. For steps, see Install wInsight Analytics 
Desktop. 

2. Share the wInsight Analytics Desktop installation folder.  

 

3. From the client PC, locate and run the DoRegAll.bat file, which is in C:\Program Files 
(x86)\Deltek\wInsight Analytics\ (for 32 bit) or C:\Program Files\Deltek\wInsight Analytics\ 
(for 64-bit), on the server. 

To run: 

a. Open an Administrative Command Prompt. The location of the command prompt varies 
depending on the operating system. For example, In Windows 10: 

i. Click Start » All Programs » Accessories.  

ii. Right-click Command Prompt and select Run as Administrator. 

Note: This setup requires you to install wInsight Analytics Desktop only on the server and not on the 

client PCs. 

Note: There are different ways to do this. For example, in Windows Server 2016, you can 

create a file share using the New Share wizard on the File and Storage Services page of the 

Server Man. 
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b. Use the “net use” command to map the drive (for example, Z:\, but it could be any drive 
available for mapping). This step ensures that you can see the drive. 

 

c. Press Enter. 
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d. Go to the mapped drive and run DoRegAll.bat. 

 

e. Press Enter. 
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f. Click OK until all the .DLL files included in the batch are registered. 

i. If UAC is enabled, go to step #4. 

ii. If UAC is not enabled, skip step #4 and continue with step #5. 

4. If UAC is enabled, on the client PC, create a mapped drive to the wInsight Analytics installation 
folder on the server. 

To map a network drive: 

a. Open My Computer. 

b. On the Tools menu, click Map Network Drive.  

c. On the Map Network Drive page, in the Drive drop-down list, enter or select the drive 
letter to map the shared resource (this should be the same drive you selected in Net Use 
command from step #3). 

d. In the Folder drop-down list, enter the server name and share name, for example, 
\\server name\share name. You can also click Browse to locate the resource. 

e. Click Finish. 

5. From the client PC, locate the Wsmde.exe file in the wInsight Analytics installation folder on the 
server using the mapped drive. 

6. Create a shortcut on the client PC. 

Installation Notes 

This section discusses additional details for installing wInsight Analytics Desktop on a server on a Local 

Area Network (LAN): 

 The Microsoft Windows Installer can perform an administrative installation of an application or 
product to a network for use by a workgroup. Your administrator can run an administrative 
installation from the command line by using the “/a” command line option. You can then install 
the product from the network to run the application. You can choose to "run-from-source" and 
the installer will use most of the product's files directly from the network. 
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 Regardless of where the application files are installed, a wInsight Analytics database can be 
located on a file server accessing a shared MS Access .MDB file or on a database server running 
Oracle or SQL Server. You can access an MS Access .MDB file if it resides on the client PC. 

 You do not need any write privileges on the server unless you need to create a data source. In 
that case, you must be able to write to the datasources.dat file which is stored in the installation 
directory by default. However, you need Read, Write, Create, and Delete privileges to the 
directory storing the wInsight MS Access (.MDB) database. 

 You can share the data sources used to access wInsight Analytics data by specifying the 
location of the datasources.dat file (which contains the connection details) in config.dat. If you 
use other Deltek products (such as Cobra and Open Plan) and store all of your data in a single 
database, you can create a single list of database connections in one shared datasources.dat file. 

The config.dat file must reside in the wInsight Analytics folder but the shared datasources.dat 

can be placed in a network shared folder and accessed by all users. This allows all users to easily 

connect to the databases configured by their system administrator. 

To update config.dat, open the file in a text editor (such as Notepad), specify the location of the 

shared datasources.dat, and restart the application. 

[SYSTEM] 

DataSources=<path>\<filename> 

 

 For an Oracle database, wInsight Analytics no longer supports Microsoft OLE DB Provider for 
Oracle (MSDAORA.DLL). To connect to a database, it now uses Oracle Provider for OLE DB 
(OraOLEDB.Oracle.1). If Oracle Provider for OLE DB is not included in the OLE DB Provider list 
on the Data Link Properties dialog box, download and install Oracle Data Access Components 
(ODAC) for the Oracle database version you are using. 

Part of this change is the conversion of the LONG data type into CLOB (Character Large Object) 

data type. CLOBS allow you to store and manipulate large blocks of unstructured data and 

provide efficient access to the data. In addition, Oracle recommends that you use CLOBs over 

LONG data types. 

 

Note: The config.dat file is installed into C:\Program Files (x86)\Deltek\wInsight Analytics or 

C:\Program Files\Deltek\wInsight Analytics by default. 

Attention: For more information, see 

http://www.oracle.com/technetwork/topics/dotnet/downloads/net-downloads-

160392.html. 
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Upgrade from an Earlier Version of 
wInsight Analytics Desktop 
When you install the wInsight Analytics Desktop, the installer automatically removes the older version. 

You can also uninstall earlier versions by using one of the following methods: 

 Use Windows’ Programs and Features to uninstall the wInsight Analytics Desktop. 

 Run the older version installer and select the Remove option on the Program Maintenance page. 

 

To upgrade an existing wInsight Analytics Desktop: 

1. Before you upgrade: 

 Create a backup of your contracts in an MS SQL, Oracle, or MS Access database. For steps, 
see the Back Up Contracts from an Earlier Version of the wInsight Analytics Database 
section. 

 Back up your custom wInsight Analytics Views, Filters, and Charts using the File » Export 
Custom Items command. This command creates a WSCUSTOM.XML file. 

2. Download the latest version of wInsight Analytics Desktop from DSM. For steps, see 
Downloading Deltek Products using Deltek Software Manager. 

3. Double-click the wInsight Analytics Desktop file and follow the installation instructions. 

During the upgrade, any MS Access .MDB files found where the latest version is being installed 

will be moved to the backup folder, which is C:\Program Files (x86)\Deltek\wInsight 

Analytics\Backup by default. For more information, see Back Up Copies of Existing MDB Files 

section. 

4. Run the batch file or scripts to upgrade database table. For steps, see the Convert an Earlier 
Version of the wInsight Analytics Database section of the wInsight Analytics Administrator 
Installation Guide. 

 It retains all data sources (from 8.3/8.31/8.3.2/8.3.3), which you can use in the latest version. 

 It displays existing users (from 8.3/8.3.1/8.3.2/8.3.3) in PPM Administrator or EPM Security 
Administrator (EPM SA). 

 

Attention: If you are performing a fresh install of wInsight Analytics Administrator, see Install 

wInsight Analytics Desktop. 

Attention: For MS SQL and Oracle, see the Set Up and Create a New Database or Convert an 

Earlier Version of the wInsight Analytics Database section of the Deltek wInsight Analytics 

Administrator Installation Guide. 
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5. Click File » Import Custom Items to restore the custom items that you backed up before the 
upgrade. 

Back Up Contracts from an Earlier Version of the wInsight Analytics Database 

Even though you can upgrade an earlier database version to the latest version, you may choose to back 

up your contracts from the earlier database version and restore them into the latest version. 

Manually Create a Backup of Contracts in an MS SQL, Oracle, or MS Access Database 

To back up your contracts manually: 

1. Run the earlier version of wInsight Analytics Desktop. 

2. Click File » Login and select the database with the contract to back up. 

3. Click Utilities » Backup to back up your contracts. Note the location where the archive file 
(.WSA) of the older version was saved. 

4. Exit wInsight Analytics Desktop. 

Back Up Copies of Existing MDB Files 

When performing an upgrade installation, any .MDB files found where the latest version is being installed 

will be moved to the backup folder which is in <installation location>\Backup by default. 

 

Note: Make sure that your recent wInsight Analytics data is backed up, especially if it is stored in the 

Sample data source which uses sample.mdb. This database is installed by default in <installation 

location>\data and might overwrite the existing one, thereby deleting your data. 
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Modify, Repair, or Uninstall wInsight 
Analytics Desktop 
wInsight Analytics Desktop provides facilities for changing which features are installed, repairing 

installation errors, and removing wInsight Analytics Desktop. Use this procedure to modify, repair, or 

remove your wInsight Analytics Desktop installation. 

To modify, repair, or remove your wInsight Analytics Desktop installation: 

1. Navigate to the location where you saved the installer and double-click the file to launch the 
InstallShield Wizard. 

2. On the Welcome page, click Next. 

3. On the Program Maintenance page, select one of the following options: 

 Modify — Select this option to change your wInsight installation. The Custom Setup page 
displays (without a Change button) where you can modify the features. Click Install.  

To change the directory where wInsight Analytics Desktop is installed, you must first 

uninstall wInsight Analytics Desktop and then re-install it into a different directory (see 

Install wInsight Analytics Desktop). 

 Repair — Select this option to repair installation errors by re-installing the wInsight 
Analytics Desktop components. On the Ready to Repair the Program page, click Install. 

 Remove — Select this option to uninstall wInsight Analytics Desktop. On the Remove the 
Program page, click Remove. 

4. When the process is complete, click Finish to exit the InstallShield Wizard. 
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Convert an Earlier Version of the MS 
Access Database 
Use this procedure to convert an older version of the wInsight Analytics database to the latest version. 

 

This section only covers the steps for converting an MS Access Database.  

 

Convert an MS Access Database 

For an MS Access database, you either convert the database or create a backup of wInsight Analytics 

contracts and restore it, depending on which version you are coming from. 

Upgrade from the Previous Version  

No one should be using the database during this conversion process. Deltek recommends that you back 

up your wInsight Analytics contracts before performing the conversion. 

 

To convert an MS Access database, you need: 

 wInsight Analytics Desktop (latest version) installed 

 A fully working or verified operational database 

 A data source connection to that database 

 

  

Attention: Backing up and restoring your data is an alternative to converting your database. For 

more information, see Upgrade from an Earlier Version of wInsight Analytics Desktop. 

Attention: For MS SQL and Oracle, see the Set Up and Create a New Database section of the Deltek 

wInsight Analytics Administrator Installation Guide. 

Attention: For more information, see Manually Create a Backup of Contracts in an MS SQL, Oracle, 

or MS Access Database section. 

Attention: To create a clean MS Access database, see Create an MS Access Database. 
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To convert an MS Access Database: 

1. Using Query Analyzer or the equivalent, connect to your existing wInsight Analytics database. 

2. Click File » Open to open the corresponding upgrade script, depending on which version you 
are coming from. 

 

Upgrade from Do this 

8.3 / 8.3.1 / 8.3.2 Select and run WA833_Upgrade_Access.qry against the created 

database. 

3. Click  to run the convert query. 

4. Deltek recommends that you recalculate a contract to check that the conversion process 
completed successfully. 

 

Note: By default, the script is in C:\Program Files (x86)\Deltek\wInsight 

Analytics\data\Access. 

Attention: For more information, see Recalculate a Contract in the wInsight Analytics 

Desktop and wInsight Analytics Administrator Online Help. 
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Set Up and Create a New Database 
The wInsight Analytics Desktop is installed and configured to use an MS Access database by default and 

does not require that you have an MS SQL Server or Oracle database to use the software. Installing the 

application also installs the sample.mdb database file which contains the sample MOH-2 contract. 

The wInsight Analytics installer provides batch files to assist with the creation of a new wInsight 

Analytics database. These batch files are saved in C:\Program Files (x86)\Deltek\wInsight 

Analytics\data\ and are database-specific. You can also create the wInsight Analytics database by 

running the scripts individually during the installation process. 

MS SQL Server and Oracle Databases 

For an MS SQL Server or Oracle database, the Database Administrator (DBA) needs to run certain scripts 

for you to use the Run Script functionality under the Utilities menu in wInsight Administrator.  

 

MS Access Database 

For an MS Access database, use the blank database file that wInsight Analytics Administrator installs.  

 

Steps for Setting Up a New Database 

To use a new database, you must create a new database (use the blank834.mdb file for MS Access or 

create a database for Oracle or MS SQL Server) and set up a data source.  

1. Create a new database. 

 Create an MS Access Database 

 Create an MS SQL Server Database 

 Create an Oracle Database  

Attention: For more information, see the Appendix D: wInsight Analytics Administrator Run Script 

Setup section of the Deltek wInsight Analytics Administrator Installation Guide. 

Attention: If you want to share Users, Groups, Roles, and EPM Security Administrator (EPM SA) 

between Deltek PPM products, these products need to share the same database. wInsight Analytics 

can be installed in the same database as the other Deltek PPM products. 

For more information, see the Appendix C: Using One EPM Security Administrator for All Deltek PPM 

Products section of the Deltek wInsight Analytics Administrator Installation Guide. 

For details on the sequence of scripts to be executed, see the Cobra, Open Plan, and PM Compass 

Installation Guides. 
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2. Set up a data source. You can use the Data Tool to perform this task. 

 

Create a New Database 

The steps in this section only applies to the MS Access database type. 

Create an MS Access Database 

wInsight Analytics Administrator installs a blank834.mdb database file. This database file contains no 

contracts. Use it when you want to start a new group of contracts without having to delete existing ones 

first. Use wInsight Analytics Administrator to add contracts to a new database. 

To create a clean MS Access database: 

1. Open Windows Explorer and search for blank834.mdb which is in C:\Program Files 
(x86)\Deltek\wInsight Analytics\data\Access by default. 

2. Copy the file to your preferred location.  

3. In Windows Explorer, rename the copy of blank834.mdb. 

 

 

 

 

Attention: For MS SQL and Oracle, see the Set Up and Create a New Database section of 

the Deltek wInsight Analytics Administrator Installation Guide. 

Attention: You can use wInsight Analytics Administrator to add contracts to the new 

database manually or to add contracts to the new database by importing transfer files. For 

more information about data source connection, see Appendix A: Data Tool. 
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Advanced Setup Options 
Configure wInsight Analytics Desktop to Use Long Element Descriptions  

Configuring wInsight Analytics Desktop to use the Long Description field requires two steps: 

1. Insert the Long Description field (LongDesc) into the Sort window or a view that uses the Long 
Description field. For more information, see the Sort Windows Overview section of the online 
help. 

2. Create a Registry setting (a task which should be performed by someone familiar with the 
Registry). The following table identifies the Registry setting that controls which description is 
used. 

Description Option Parameter & Settings 

15 character description No Registry Parameter or Setting (default) 

50 character description LongDesc=1 

To create a long description registry setting: 

1. Click Start » Run. 

2. On the Run dialog box, enter either regedit.exe or regedt32.exe and click OK. 

3. In the Registry Editor, navigate to the 
HKEY_CURRENT_USER\Software\Deltek\wInsight\834\Settings key folder. 
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4. Click Edit » New » DWORD Value (32-bit) Value. A New Value #1 entry is highlighted in the 
right-hand window of the Registry Editor. 

5. Type LongDesc and then press ENTER. The name New Value #1 should be replaced with 
LongDesc. 

6. Double-click the LongDesc item. 

7. On the Edit DWORD Value dialog box 

a. In the Base group box, select the Decimal option. 

b. Enter 1 in the Value Data field. 

c. Click OK. 

 

A "1" at the end of the string of 0's should appear in the Data column on the right side. 

8. Click File » Exit to close the Registry Editor. 
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Troubleshooting wInsight Analytics 
Desktop 
This section provides information on how to contact Deltek if problems occur during installation. It also 

includes a list of errors that may occur during installation as well as viable solutions. 

Contact Technical Services 

While Deltek has worked hard to ensure an easy installation, in certain situations installation can be 

complex, and may require special consideration. The complexity can increase, for example, with multiple 

server installation, database replication, or other complex deployments. In such cases, we recommend 

contacting Deltek Technical Services to schedule your wInsight Analytics Desktop installation. 

Deltek's team of technical consultants can assist you with your installation in a timely manner. When you 

contact the Technical Services department, technical specialists schedule a phone and Microsoft Live 

Meeting appointment to walk your IT staff through your wInsight Analytics Desktop installation. Deltek’s 

involvement ensures that all applications are installed properly, regardless of the complexity of the 

deployment scenario. 

The Technical Services department’s assistance is billed on a time and materials basis. While installation 

assistance is not required, it is recommended that you optimize your investment in wInsight Analytics 

Desktop from the time of installation. Many Deltek clients have benefited from the Deltek Technical 

Services department’s experience and knowledge of the wInsight Analytics Desktop installation process. 

Send Files to Deltek 

If you encounter any problems while installing wInsight Analytics Desktop, contact Deltek Support 

Center for assistance. To help us resolve your installation issues as quickly as possible, send the 

installation logs to Deltek when requesting assistance with troubleshooting the installation. 

Error Encountered When Using the SQL.NET Framework Database Provider 

When using the SQL.NET Framework as your database provider, you may encounter an SSL certificate 

validation error during login, similar to the following. 

 

If you encounter this error, Deltek recommends that you consult your database administrator and ensure 

that your server instances are configured with the certificates required by Microsoft. 

https://deltek.custhelp.com/
https://deltek.custhelp.com/
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Attention: For more information, refer to the following Microsoft article: “Encryption and Certificate 

Validation in Microsoft.Data.SqlClient.” 

https://learn.microsoft.com/en-us/sql/connect/ado-net/encryption-and-certificate-validation?view=sql-server-ver17
https://learn.microsoft.com/en-us/sql/connect/ado-net/encryption-and-certificate-validation?view=sql-server-ver17
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Appendix A: Data Tool 
Use this tool to add new, edit, and delete data source. If you have more than one database, you can 

specify additional databases using this tool. The data tool is installed when you install the wInsight 

Analytics Desktop or wInsight Analytics Desktop application. 

Add a Data Source 

Use this procedure to add a data source. 

 

To add a wInsight Analytics data source using the Data Tool: 

1. Click Start » All Programs » Deltek wInsight Analytics » Deltek wInsight Analytics Data Tool. 

2. On the Data Sources dialog box, click Add. 

3. On the Data Link Properties dialog box, select the OLE DB provider that matches the database in 
which your data is stored.  

The OLE DB providers in the table below are only examples. You must select the appropriate 

driver for your environment. 

Database OLE DB Provider 

MS Access  Microsoft Office 15.0 Access Database Engine OLE DB Provider 

 Microsoft Office 16.0 Access Database Engine OLE DB Provider 

Oracle  Oracle Provider for OLE DB 

MS SQL Server  Microsoft OLE DB Provider for SQL Server, Microsoft SQL Server 

Native Client 

 Microsoft OLE DB Driver for SQL Server 

 

4. Click Next or the Connection tab. 

Attention: You can add a new data source using the Data Tool or EPM SA. For more information 

about adding a data source using EPM SA, see Deltek EPM Security Administrator Help. 

Attention: For Oracle users, if you cannot find the Oracle Provider for OLE DB in the OLE DB 

Provider list, download and install Oracle Data Access Components (ODAC) for the Oracle 

database version you are using. For more information, see 

http://www.oracle.com/technetwork/topics/dotnet/downloads/net-downloads-

160392.html. 

http://www.oracle.com/technetwork/topics/dotnet/downloads/net-downloads-160392.html
http://www.oracle.com/technetwork/topics/dotnet/downloads/net-downloads-160392.html
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5. On the Connection tab, enter or select appropriate information. The contents of this tab may 
vary depending on the database provider. 

6. Select a database and provide the necessary connection details. 

Database Connection Details 

MS Access  Click the ellipses (...) button to browse and select a wInsight .MDB file. 

 Enter Admin in the User Name field 

 Leave the Password field blank. 

 Select the Blank Password option 

Oracle Obtain the following from your IT: 

 Server Name 

 Database Name  

 User Name 

 Password 

If there is a password, do not select the Blank Password option. 

MS SQL Server Obtain the following from your IT Administrator. 

 Server Name 

 Database Name  

 User Name 

 Password 

If there is a password, do not select the Blank Password option. 

 

 

Note: Always select the Allow saving password option to encrypt the password and save it 

on disk. 

Note: If you use SQL Server Native Client, you must set Persist Security Info to True on 

the All tab of the Data Link Properties dialog box. To do this: 

a. On the Data Link Properties dialog box, click the All tab. 

b. Scroll down and double-click Persist Security Info. 

c. Select True in the Property Value field on the Edit Property Value dialog box. 
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7. Deltek recommends that you click the Test Connection option to verify that the connection to 
your database works.  

8. On the Microsoft Data Link message box, click OK to save the information and close the Data 
Link Properties dialog box. 

9. On the Edit Data Source dialog box, in the Database Name field, enter a descriptive name. 

 

10. If you selected a database name on the Connection tab of the Data Link Properties dialog box, 
leave the Database Name (Schema) field blank. 

11. Click OK. The new data source is added to the list on the Data Sources dialog box. 

12. On the Data Sources dialog box, click OK. 

Edit a Data Source 

Use this procedure to edit the properties of an existing data source. 

To edit a wInsight Analytics data source: 

1. Click Start » All Programs » Deltek wInsight Analytics » Deltek wInsight Analytics Data Tool. 

2. On the Data Sources dialog box, select a data source and click Edit. 

3. On the Edit Data Source dialog box, click Data Link Properties. 

 

4. On the Data Link Properties dialog box, enter or select your new preferences on the tabs. 

5. Click OK to save your modifications and close the Data Link Properties dialog box. 

6. Click OK to close the Edit Data Source dialog box. 

7. Click OK to close the Data Sources dialog box. 

Delete a Data Source 

Use this procedure to delete an existing data source. If you delete a data source that is used in wInsight 

Analytics Administrator or wInsight Analytics Desktop, the system prompts users to select a different 

data source the next time they try to access the application.   

To delete a wInsight Analytics data source: 

1. Click Start » All Programs » Deltek wInsight Analytics » Deltek wInsight Analytics Data Tool. 

2. On the Data Sources dialog box, select the data source that you want to delete and click Delete. 

3. On the confirmation dialog box, click Yes. 

4. Click OK. 

 

Note: The Database is Unicode field is not used by wInsight Analytics. 

Note: The Database is Unicode field is not used by wInsight Analytics. 
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Appendix B: Using the PPM Security Tools  
PPM provides security tools that are crucial for managing various aspects of the PPM solutions.  

The Deltek EPM Security Administrator and Deltek PPM Administrator enable you to manage license 

keys, users, groups, roles, and access to various PPM applications. Download either tool (PPM 

Administrator 1.0 or EPM SA 8.x) separately from DSM before installing it. 

 

Attention: Deltek strongly recommends installing either PPM Administrator 1.0 or EPM SA 8.6, but 

not both, as running them together could enable incompatible features, such as multiple licenses.  

Once you install PPM Administrator 1.0 or EPM SA 8.6, you can use it across all PPM products. If you 

use PPM Administrator, you can access it via a URL because it is a web-based tool. If you use EPM 

SA 8.6, you can only access it on the computer where you installed it. 

For more information on these security tools, see their respective Installation Guides and Help 

Systems. 



 

Installation Guide 36 

 

Appendix C: If You Need Assistance 
If you need assistance installing, implementing, or using wInsight Analytics, Deltek makes a wealth of 

information and expertise readily available to you. 

Customer Services 

Deltek has always maintained close relationships with client firms, helping with their problems, listening 

to their needs, and getting to know their individual business environments. A full range of customer 

services has grown out of this close contact, including the following: 

 Extensive self-support options through the Deltek Support Center 

 Phone and email support from Deltek Support Services analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Deltek Support Center 

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing 

Support Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 

Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Deltek Support Services analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

Attention: Find out more about these and other services from the Deltek Support Center. 
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 Initiate a Chat to submit a question to a Deltek Support Services analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Additional Documentation 

The following table lists the Deltek documentation available for this release. Except where noted, all the 

user guides and quick reference guides listed in this table are available for download from the Deltek 

Support Center. 

Document Name Description 

Deltek wInsight Analytics Desktop Release Notes This document contains a summary of the 

technical considerations, major features, 

enhancements, software issues resolved, and 

known issues of the application. 

Deltek wInsight Analytics Desktop and wInsight 

Analytics Administrator Help 

This document contains detailed information and 

instructions on how to use various features of 

both applications. 

Deltek wInsight Analytics Product Overview This document provides a high-level overview of 

the product together with some guidance as to 

which modules should be installed to meet the 

needs of individual users. Most users would not 

need access to all modules. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 

from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 

screen for help. 

https://deltek.custhelp.com/
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